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1.0 Introduction to the Taxonomic Editor

The Taxonomic Editor has been developed as part of the EDIT Cyberplatform for Taxonomy; a collection of tools and services which together cover all aspects of the taxonomic workflow. EDIT is a collection of 28 leading European, North American and Russian institutions formed in the response to a call of the European Commission, issued in 2004, for a “network in Taxonomy for Biodiversity and Ecosystem Research”. 

Development of the Taxonomic Editor is part of EDIT Work Package 5: Internet Platform for Cybertaxonomy: Tools, Sharing, Networking and Integration. The tools are all open access, free, do not require licenses, and are downloadable from the EDIT website. Data stored in the Taxonomic Editor will be linked to other applications of the Cyberplatform via the Common Data Model (CDM) Library, where the data is stored. So, for example, your Taxonomic Editor dataset can be easily published online using the EDIT DataPortal application that can extract your data from the CDM. No data transformation is required by you. The Editor also supports importing and exporting to and from  a range of databases , taxonomic community data formats and import from Excel. 
The goal of the Taxonomic Editor is to provide a next-generation tool that moves beyond the form-based data entry of web-based tools like the Berlin Model Web Editor. It has been designed with specific philosophies giving the user:

1. All the benefits of a database without rigid data entry rules.

A unique feature of the Taxonomic Editor is its parsing capability. Parsing is the action of recognising distinct elements within a string. This means that data can be entered as ‘free’ or unstructured text, and as you type the parser separates each element of the text string and puts them into the correct data fields within the database. This makes data entry easy, but also enables manipulation of data as in a standard database.

The core workflow involves: 

i. Entering data as a normal text string in a taxonomic style. 

ii. The data is parsed as it is entered. 

iii. Reviewing whether the data has been parsed correctly and editing if necessary. 

2. Ability to enter data in the format required by the user.

A second defining feature of the Editor is that it has been designed to minimise system intervention so as not to hinder the work flow. Rather than enforcing data integrity upon input, warnings are given when any rules have been broken. When the mouse hovers over data that has been marked as problematic, the problem will be explained, along with possible corrections, however the software will not force you to change your data. 
3. Useability and customisation options.

The Editor has been designed to feel intuitive keeping the number of new movements or gestures you must learn to a minimum. Also, the Taxonomic Editor allows for individual customisation of the fields within the data entry sheet to facilitate an efficient data entry process. For example, you can choose which taxonomic relationships and rank types are given as options, and for some data fields you can create your own options. There are also separate configurations for users using the Botanical and Zoological Codes of Nomenclature. 

You will notice that not all of the features of the Taxonomic Editor are yet functional; development of the application and the manual are still ongoing. Version  4 of the Taxonomic Editor will be released in 2011; smaller updates will be made available on the EDIT WP5 website. 

4.  Bulk Editing

The Taxonomic Editor has a bulk editing facility that allows you to edit several records at one time. This will be useful, for example, if the name of a genus has changed as well as all the species records associated with that genus. This saves time and improves data consistency and integrity. The bulk editor can also be used to merge duplicate records that may be found in large datasets after import, for example.
About the Manual

Most of the manual has been produced whilst running the Taxonomic Editor on Microsoft Vista and Windows 7. If you have a different operating system your screen may have a slightly different appearance to the screen shots in the manual, however the actual work flows should not be affected. Where the work flows may differ these have been detailed separately, however, the manual has not yet been completed for use on Apple Mac systems.
This version of the manual for the Taxonomic Editor has been designed to provide an overview of the design philosophies and capabilities of the Taxonomic Editor. It is not intended to be exhaustive, but will allow you to make a basic taxonomic treatment.
Within the work flow descriptions that follow the symbol (>) indicates a progression from one step in a work flow to the next. Screen shots relate to the steps in the work flow given above the screen shot, not below. Red arrows given in screen shots from one window/menu/box to another indicates that the second will appear after carrying out the action in the first.
2.0 Setting up the Taxonomic Editor

 SHAPE  \* MERGEFORMAT 



Downloading the Taxonomic Editor 

The Taxonomic Editor, as well as other EDIT Cyberplatform components, can be downloaded via the Cybergate at http://dev.e-taxonomy.eu/platform/ . There are no additional system features required for the Taxonomic Editor to work.
1. Click EDIT Desktop Taxonomic Editor within the Cybergate. A description of the Taxonomic Editor and further options will appear to the right of the Cybergate.

2. Click Download in the section on the right.  
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You will be taken to the Taxonomic Editor Download Site.

Alternatively, you can access the download site directly by entering http://ev.e-taxonomy.eu/trac/wiki/TaxonomicEditorDownload into the address bar of your browser.
3. Click on the download link and then navigate to the latest version of the Taxonomic Editor  
[image: image191.jpg]Dounoad Help Manusl (0F)
Parer Help Website

CheckforUpdotes
ol New Softvare..

Wy Csicaton |
Reveion of Abpia

About Tasonomic Edtor
About the OITPltorm



[image: image4.jpg]Taxonomic Editor Download Site
The most recent version of the Taxonomic Editor will always be available here.
Downloads
> http://wpS.e- taxonomy.eu/download/ taxeditor
System requirements
The current version of the Editor has been tested on:

« Windows Xp
« Windows Vista









[image: image192.jpg]PRt el B
- o name o authrship not arabl o name.rfeencesepaaion ot post
T Wl Thde i ey e i it S e Akl sl






[image: image5.jpg]Name Lastmodified Size Description

& parentDiect
[ AR 07-5ep-2010 13:44
E3300bety  07-5ep2010 1344
README MtmI  08-Dec:2010 11:41
@ archives 05-112-2010 17:29
(23 stavte/ 07-5ep-2010 13:44
(B3 usablltetest! 0544212010 1720





[image: image193.png]



[image: image6.jpg]Name Last modified Size Description

& pareniDiect E

) EDMaonomiEtortsetianuaoat 04 For2070 1505 3510
(N EDITor tnus 3130 bota onsap 152010 1508 s

¥ EDITor winspwins2186.30 vet rse28p 15.uk2070 1508 56
TatonomicE dtor Usertanua Verslon? 1.t 04552010 1505 38M










                                           
The following steps will differ slightly depending on whether you are using Mozilla Firefox or Internet Explorer and the operating system you are using. If you are using Mozilla Firefox on Vista, you will be taken straight to the “Save As” details pop-up box; go to Step 5. If you are using Internet Explorer or Mozilla Firefox on an older operating system such as Windows XP, you will see a pop-up box the same as or similar to the ones shown below; go to step 4.
4. Click the Save button or choose the Save option. Click the OK button if necessary. The “Save As” details pop-up box will open; go to step 5. 
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  Mozilla Firefox and Vista/Windows XP
           
Internet Explorer and Vista/Windows XP
5. Choose a destination for the folder containing the Taxonomic Editor (Tip! You may have to click a Browse Folders button as shown below in order to access your computer’s directory). Make a note of the destination.
6. Enter a file name or use the default file name. Make a note of the file name.
7. “Save as type” should be Compressed (Zipped) Folder.
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Tip! If you are using Mozilla Firefox and you do not see a pop-up box as shown above, your internet options may not be set up to ask for confirmation on where to save files that you download. The folder will automatically be saved to your desktop. If you wish to change this setting, see the Troubleshooting instructions at the end of this section.

8. Click the Save button; a download progress bar will appear. The download may take a few minutes.
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You now have to extract the contents of the compressed folder; the exact method will depend on whether you are using Mozilla Firefox or Internet Explorer (see Extracting the Contents of the Compressed Folder (Internet Explorer) or Extracting the Contents of the Compressed Folder (Mozilla Firefox) below).

Troubleshooting: Mozilla Firefox Settings
If your internet settings are set up to not ask you for confirmation as to where to save files and folders that you are downloading, they will automatically be saved to your desktop. If you want to change this setting open the Mozilla Firefox start page > click on the Tools menu on the toolbar at the top of the screen > click on Options. A new pop-up box will open. Click in the box to the right of the text “Always ask me where to save files” and click OK:
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Extracting the Contents of the Compressed Folder (Internet Explorer)
1. Locate the compressed Taxonomic Editor folder in the destination in which you saved it.

2. Right-click the folder.

3. Click the Extract Files option. 
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A new pop-up box will open for you to choose the destination where the extracted folder will be placed. The default destination will be the location of the compressed folder; if you wish the extracted folder to be in the same place as the compressed folder there is no need to change the destination.
4. Select the destination and click the OK button. The folder will be extracted; this may take a few minutes. 
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You should now create a Desktop shortcut for the Taxonomic Editor (see Creating a Desktop Shortcut (Windows only) on page 9).

Extracting the Contents of the Compressed Folder (Mozilla Firefox)

If you have downloaded the Taxonomic Editor using Mozilla Firefox, when the download is complete a pop-up box will open to inform you, as shown below. 
1. Open the folder by double-clicking it in the pop-up box:
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Alternatively, locate the folder in the destination in which you chose to save it, and double-click the .zip folder. 
2. Click the Extract All Files button:
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A new pop-up box will open for you to choose the destination where the extracted folder will be placed. The default destination will be the location of the compressed folder; if you wish the extracted folder to be in the same place as the compressed folder there is no need to change the destination.

3. Select the folder destination using the Browse button or leave the default destination.

4. Ensure “Show extracted files when complete” is selected, and click the Extract button. 
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The contents of the compressed folder will be extracted; this may take a few minutes. 

You should now create a desktop shortcut for the Taxonomic Editor (see Creating a Desktop Shortcut (Windows only) on page 9).

Creating a Desktop Shortcut (Windows only)
It is recommended that you create a desktop shortcut to the file location of the TaxonomicEditor.exe file as soon as you have downloaded and installed the Taxonomic Editor. You will then be able to open the Taxonomic Editor using the shortcut instead of having to navigate to the .exe file location. These instructions apply only to Windows systems.
1. Locate and open the extracted Taxonomic Editor folder in the destination in which you chose to extract the folder (if you selected the “Show extracted files when complete” option when extracting the folder it will automatically open). 

2. Right-click the TaxonomicEditor.exe file; a drop-down menu will appear.

3. Click the Send To option.

4. Click the Desktop (create shortcut) option.
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This will create a shortcut on your desktop that will automatically open the Taxonomic Editor:
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You can double-click this icon to open the Taxonomic Editor. 
Opening the Taxonomic Editor

1. Double-click the Taxonomic Editor shortcut on your desktop (if you have not created a shortcut it is recommended that you do so).
A security warning may open; this is a standard Windows security warning asking for confirmation that you trust the source of the application. 

2. If you have received a Security Warning pop-up, deselect the option “Always ask before opening this file” – this will prevent this pop-up box from appearing every time you run the Taxonomic Editor.

3. Click the Run button to continue opening the Taxonomic Editor. 
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4. The Taxonomic Editor will load and open; this may take a minute or two the first time you open the Taxonomic Editor.

5. The first time you run the Taxonomic Editor, you will be asked to choose a nomenclatural code. Select the code you wish to use and click the OK button.
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A pop-up box will open confirming your choice of nomenclatural code.

You can change the nomenclatural code at any time in the “Preferences” (see The Preferences Menu on page 29).
Logging In

Every time you open the Taxonomic Editor a log-in pop-up box will open. This feature is not yet fully operational but will be in the next release of the Taxonomic Editor. It allows changes to be tracked if there will be multiple users of the underlying CDM data store and you need to track changes. There are currently no authorization mechanisms in place and the login is therefore solely for authentication. Each user can log in under their own account. Alternatively, it is possible to bypass the log-in by clicking the Cancel button.
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Downloading and Installing Updates 

Periodic updates of the Taxonomic Editor may be released. These can be usually be accessed via the Help menu of the Taxonomic Editor, however this feature is not available in this version of the Editor. Therefore to install updates you should remove your current version of the Editor as described in section Removing the Taxonomic Editor on page 13 and reinstall as described in section 2.1 to 2.6 above. 
Enabling Unicode Characters

The Taxonomic Editor uses the operating system's default font to display all the fields that store specimen data. On a Macintosh, the system font is Unicode-compliant, so there is no problem displaying specimen data that includes symbols such as ♀ and ♂. On some, mainly older Windows systems, this is unfortunately not the case. To ensure that all data will be visible on your system, you may need to install a Unicode-compliant font on your Window’s system. If you are experiencing this problem it can be resolved quite easily:
· Right-click on your Desktop.

· Click Properties in the drop-down menu > Click the Appearance tab > Click the Advanced option. A new pop-up box will open. 

· Click the “Item” drop-down menu and select Message Box.

· Click the “Font” drop-down menu and select Arial Unicode MS.

The Unicode characters should now appear in the Taxonomic Editor.
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If the Arial Unicode MS font is not shown as an option in the Font drop-down menu, and you are using Microsoft Office 2000 or later, you can obtain the font from your Microsoft Office CD: 

5. Insert the Office CD, and do a Custom Install. 

6. Choose Add or Remove Features. 

7. Click the (+) next to Office Tools > International Support > the Universal Font icon > Arial Unicode MS font.

8. Follow the instructions 1-2 above.

Removing the Taxonomic Editor
To remove the Taxonomic Editor from your system, locate the folder in which the taxonomic editor.exe file is stored on your system and simply delete the folder. If you cannot find the folder and you are on a windows platform and have created a desktop shortcut to the Editor you can determine the path to the folder by looking at the properties of the shortcut. Do this by right clicking on the shortcut and selecting the properties option from the drop down menu.  In the Shortcut tab of the properties window look in the ‘Target field’ this will reveal the location of the taxonomic editor. 
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Navigate to the Taxonomic Editor folder and delete it by simply clicking once on the folder and pressing the Delete button on the keyboard. A pop-up box will appear asking “do you really want to delete this folder”; press Return on the keyboard to confirm. 
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You will also need to delete the cdm.Library folder where your local data is stored. The exact location of this folder will depend on your computer system. In order to locate it, run a system search as detailed for different operating systems:

2.1.1 Windows XP and older Systems
1. Click on the Windows Start button at the bottom left of your computer screen (on newer systems you may only have an untitled Windows icon).

2. Select the Search button; a new pop-up box will appear.

3. Select Search All Files and Folders; a new pop-up box will appear.

4. Select the locations on your computer that you would like to search.

5. In the search bar at the left hand side of the box enter “cdm.Library”.

6. Click the Run Search button.

The search will be carried out and the results will be shown in the main panel of the pop-up box. The search will return a list of matching results. There should only be one folder called “cdm.Library”.

7. Within the panel of the search box, click the cdm.Library folder once.

8. Press Delete on the keyboard.

A pop-up box will appear asking “do you really want to delete this folder”.

9. Press Enter on the keyboard to confirm.

The cdm.Library folder will be deleted.

If you cannot locate your cdm.Library folder using this method, please see the Microsoft help page for Windows XP at:

http://support.microsoft.com/kb/308895 

You can now delete the shortcut from your desktop: click on the shortcut, press the delete button on the keyboard; a pop-up will ask you to confirm the deletion; click the OK button.

2.1.2 Windows Vista

1. Click on the Windows Start button at the bottom left of your computer screen. The Start menu will open.

2. Click in the search bar at the bottom of the menu.

3. Enter “cdm.Library”:
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A menu of matching search results will open.

4. Click the Search Everywhere option at the bottom of the search results menu.

A “Search results in indexed locations” window will open. At the left hand side is a list of locations with matching folder names. One of these will be your user location on your PC.

5. Click the arrow icon at the left of your user directory to expand the menu. The cdm.Library folder will be found in the menu.

Click the cdm.Library folder once and press the Delete button on the keyboard. A pop-up box will appear asking “do you really want to delete this folder”.

6. Press Enter on the keyboard to confirm.

The cdm.Library folder will be deleted.

If you cannot locate your cdm.Library folder using this method, please see the Microsoft help page for Windows Vista at:

http://windowshelp.microsoft.com/Windows/en-GB/help/ed53ade7-cfb8-425a-841d-6a6aa6991dfe1033.mspx 

You can now delete the shortcut from your desktop: click on the shortcut, press the delete button on the keyboard; a pop-up will ask you to confirm the deletion; click the OK button.
Creating Multiple Datasources 
Multiple Datasources can be used to create separate databases or datasets within the Taxonomic Editor. You may want to create a separate datasource for different users or for different taxonomic treatments, allowing you to keep the information separate.

With the Taxonomic Editor installed and open on the machine:

1.
Ensure that the Datasource panel is shown:

Window > Show View > Datasource

[image: image28.jpg]



The Datasource panel will open at the bottom of the Taxonomic Editor window.

2.
Press the right-click of the mouse with the cursor pointing within the Datasource panel; a drop-down menu will appear.

3. Click New:
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The “Create New Datasource” panel will appear.

4. Enter a name for the Datasource in the Datasource Name field:
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5. Click the arrow icon to the right of the Database Type field; a drop-down menu will appear.
6. Click the “H2 Database” option.
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The drop-down menu will close.

7. Click Next.
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The “Enter credentials for embedded H2 database” pop-up box will open. 

8. Enter a Database name (for example the name of a user or a taxonomic group).

9. Select ICBN or ICZN as appropriate. 
10. Click Finish. 
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Please Note: There is no need to input a user name or password. Although you can create a user name and password if you wish, the enforcement of this function is not yet operational, therefore a user will be able to edit any datasource without using the username and password.

The new Datasource will appear in the Datasource panel:
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The process to create new datasources can be repeated as many times as desired. 
Connecting to a Different Datasources

The open Datasource is indicated by an open folder icon in the Datasource panel:
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To open a different Datasource .
1.
Click the right mouse button with the cursor pointing to the Datasource you wish to select.

2. Click Connect. 
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 The “Confirm Datasource Change” pop-up box will open.
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3. Click OK. 

The Taxonomic Editor will restart with the selected Datasource open. 

If you are opening a Datasource with a Nomenclatural Code that is different to the preferred Nomenclatural Code that you selected when installing the Taxonomic Editor, you will receive a warning:
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4. Click OK; the warning will close and the Nomenclatural Code will be changed to match that of the Datasource.
3.0 Getting to Know the Taxonomic Editor
 SHAPE  \* MERGEFORMAT 



Parts of the Taxonomic Editor

This section gives a brief overview of the main sections of the Taxonomic Editor and some of the terminology you will need to be familiar with.

The first time you open the Taxonomic Editor you will see it is divided  into three columns with a tool bar (1) running across the top. Data entry and data navigation panels and tabs can be arranged as you wish within the workspace. The figure below shows the default panel and tabs layout for the taxonomic perspective (See section 4.2.3 Customising Views of the Taxonomic Editor page 40 for an explanation of perspectives).
Left hand column:  Taxon Navigator panel (2)

Middle column: Taxon name panel (3), Descriptive panel (4) and Media panel (5)
Right hand column: Descriptive Panel (6) and Supplemental Data panel (7)
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The different parts of the Taxonomic Editor are outlined below. To view those which are not shown in the default view see section 4.2 The Show View Menu page 41.

A/ The Toolbar (1) contains a search bar to search within your data set and the Menus (see 3.2 The Menus below for a list of menus available and their functions).

B/ The Taxon Navigator panel (2) provides a hierarchical representation of the relationships between the taxa within your dataset.

C/ The Taxon Name panel (3) – This panel contains a tab for each open taxon. Information entered here will be parsed directly and displayed in the taxon details panel .
D/ Taxon Data Panels - There are four different taxon data panels where data types can be selected and added for Descriptive(4), Supplemental (6), Media (5) and Polytomous keys (not shown – not yet functional). When an item in a pane associated with one of these tabs is selected the data associated with the selection will be displayed and can be edited in the details panel (6).

E/ The Details Panel (6) – The contents displayed in this panel will vary depending upon the selections in the other panels. When a taxon is currently selected this panel displays the parsed taxon details. When an element in a Taxon data panel is selected then the details of the selected item are displayed here.  When the bulk  editor is activated the edit controls for the bulk editor will also be displayed in this panel

F/ Management Panels - There are 4 database management panels, none of which open in the default view. 
The Datasource panel shows which datasource, or database, the Taxonomic Editor is currently connected to. You can connect or delete connections to different datasources or create a new datasource. 

The User Manager panel will be used to view, edit, create or delete user accounts in order to track changes to your data, for example “Created By” and “Updated By”; it is not yet operational.
Messages - experimental feature, not yet fully functional.

Reporting - experimental feature, not yet fully functional.
For more information on customising the layout of the editor refer to section 4 of this manual.

The Menus 
                                                     [image: image41.jpg]General Edit Window Help




File

The General menu has the following options:

> New; for creating a new Taxon or Reference, name, person, specimen or classification
> Close; > Close All; > Save; > Save All; these functions operate on the taxon or taxa records that are open in the Freetext panel.

> Import; for importing data for an existing database or file.
> Export; for exporting data to a database or file.
> Login; to open the User login pop-up box. 

> Exit; for closing the Taxonomic Editor.



> Recently opened records are listed at the bottom of the menu. Click on a taxon name in this list to open the taxon in the Freetext panel.
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Edit
> Undo; > Redo; these commands are currently operational only when using the Bulk Editor (see below).
> Cut; > Copy; > Paste; > Delete; these commands apply to all panels of the Taxonomic Editor apart from the Taxon Navigator panel where only the Delete function works.
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Window


The Bulk Editor is used to edit lists of: 
> Names

> Name Relationship

> References

> Specimens or Observations

> Authors and Author Teams

See Bulk Editing on page 76 for further details.
> Show View; to open panels that have previously been closed (again, see Customising the Taxonomic Editor on page 30).

> Preferences; for managing preferences (see Customising the Taxonomic Editor
                             on page 30).
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Help

> Download Help Manual 

> Parser Help Website; to access help and support on parsing.
> Check for Updates (Not yet functional).
> Install New Software Software Updates; to access any available updated from the EDIT WP5 website (Not yet functional).
> About Taxonomic Editor; to access feature, plug-in and configuration details.

> About the EDIT Platform

General Behaviours and Navigation 

3.1.1 Mouse and Keyboard Functions
In all sections of the Editor except the toolbar clicking the right mouse button will open up a context menu containing a list of possible commands that can be performed on the data element the mouse is pointing at. When no commands are available right-click will have no effect.

Most of the commands written in the manual are based on the user using the mouse. However, it is also possible to use the keyboard for some functions. Notably, when pop-up boxes require confirmation by selecting ‘OK’ or ‘Finish’, the default setting will be on the OK/Finish button, therefore you can select OK/Finish by pressing Return on the keyboard as well as clicking the button with the mouse. 

Keyboard arrows can be used to navigate around the Toolbar area to find menus and make selections. You must first click on one of the menus using the mouse, but can then use the arrows on the keyboard to navigate and the Return/Enter key to make your selection.

3.1.2 Navigating between Panels
To change the active panel of the Taxonomic Editor you must navigate between them using the mouse; clicking in a panel will activate it.
The Taxon Name Panel 
This section describes how to work within the Taxon Name panel. This is where the nomenclatural information such as accepted name, authority and nomenclatural reference as well as synonym information is displayed and updated.
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3.1.3 Activating Taxon Records in the Taxon Name Panel
Any taxon listed in the Taxon Navigator panel can be opened in the Taxon Name panel by double-clicking it in the Taxon Navigator panel. This is the equivalent of opening a word processing file within the database. The taxon record will be opened in the Taxon Name panel headed by a tab titled with the taxon name:
      Double-click here    and the taxon opens here      in a new tab
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3.1.4 Searching for a Taxon Record
If you want to open a taxon record in the Taxon Name panel but you do not know its location in the Taxon Navigator, you can search for the taxon using the search bar at the top of the Taxonomic Editor window:

1. Click in the search bar.

2. Enter a search term – this can be the full taxon name or you can use the wildcard asterisk (e.g. Des*, *halteralis, *halt* could all be used to search for Desmometopa halteralis).

Please note the search is case sensitive so you must use a capital letter where appropriate.
3. Press Return on the keyboard.
The search results will appear as a new panel as shown below. Taxon records can be double-clicked to open their records in the Taxon Name panel. 
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Also in the search results are the types of taxa that you have included in your search. For example, the search above included Taxa, Synonyms, Names (without taxa) and Common Names:
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 Should you want to limit the search results to one or a sub-set of these options, you can do so by selecting and/or deselecting your search criteria using the drop-down menu to the right of the Search bar. Simply click the arrow icon to reveal the drop-down menu, and click on the available criteria. If the criterion is included in searches there will be a tick icon to its left.
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Tip! If your search results do not show any taxa but you know there should be matches within your dataset, make sure that the search criteria are selected. If they are ALL deselected you searches will be unsuccessful.

3.1.5 Navigating between Taxon Records

It is possible to open multiple taxon records so that there are several documents open in the Taxon Name panel. Each taxon will be opened as a new document; each document can be accessed by clicking on the appropriate tab at the top of the free text panel. A double-arrow icon will displayed at the top right of the panel when there are more taxa open than are currently visible; the number refers to the number of open taxon records. 
The tabs of 2 taxon records are visible and there are 4 open taxon records that are not currently displayed
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In order to view more tabs of taxon records you can expand the width of the Taxon Name panel using the arrows that appear at the sides of the panel when you hover the mouse arrow over them (see Panel Sizes on page 40). Also, clicking on the double-arrow icon will reveal a list of all the open taxon records; those in bold are those for which the tabs are not current displayed:
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You can click on any of the taxon records in the drop-down list to activate that record in the Taxon Name panel. 
3.1.6 Closing Taxon Records

You can close the activated taxon record by clicking on the Exit icon at the right of the tab:
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If you want to close a taxon record for which the tab for the record is visible, click on the tab to activate the record and click the Exit icon as shown above.

When you have multiple taxon records open, you can close a taxon record that is not being displayed without first having to navigate to it:

1. Point the mouse arrow at the double-arrow icon at the top of the Taxon Name panel; a drop-down menu will appear.

2. Point the mouse arrow at the taxon in the drop-down list that you want to close.

3. Click the mouse so the taxon is highlighted.

4. Click the right-mouse button; the Close menu will appear.

5. Click Close. 
The taxon record will close and the taxon name will disappear from the list. 
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4.0 Customising the Taxonomic Editor 


The Preferences Menu
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Toolbar > Window > Preferences

4.1.1 Show/Hide Options of Drop-Down Menus 
Some taxonomic and descriptive elements of the Properties Sheet have numerous options, as is the nature of taxonomy, for example there are 19 options to describe the Distribution Status of a taxon. You may find that you only need to use a sub-set of these options. 
From the Preferences menu you can show or hide the options in certain drop-down boxes; this will reduce navigation time required to find your desired option.
 Options can be amended for the following fields:
Taxonomic Editor 
> Bulk Editor 

> Description:
> Distribution Status: for example “introduced: cultivated”, “introduced: naturalised”. 
> Features: the features you would like to include in your taxon descriptions, for example “common name”, “distribution” and “ecology”.
> Named Area Type:  for example “natural area”

> Preservation method:  not yet functional.

> Stage: not yet functional.


> Extension types : the types for the section ‘extensions’ in the supplemental data view for example “abbreviation “, “order”.
> Language: languages available for common name field
> Marker types : the types for the section ‘extensions’ in the supplemental data view for example “complete”, “to be checked”.
> Matching: Experimental feature, not yet fully functional.
> Taxonomic: Name Relationships Type: for example “misspelling for”, “basionym for”. 

> Name Type Designation Status; for example “monotypy”, “present designation”
> Nomenclatural Code; ICBN or ICZN.
> Nomenclatural Status Type; for example “invalid”, “conserved”. 

> Ranks; for example “cultivar”, “tribe”.
> Specimen Type Designation Status; for example “epitype”, “holotype”.
> Taxon Relationship Type; for example “overlaps”, “excludes”. 

To amend the options that are shown in the drop-down boxes in the above data fields, open the Preferences pop-up box (Toolbar > Window menu > Preferences option). The Preferences pop-up will open.
1. The menus given above are located in the Taxonomic Editor option in the menu. They can be accessed by expanding the Taxonomic Editor menu by clicking on the arrow icon:
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2. Click on the data field you would like to change from the menu on the left hand side of the pop-up. 
The existing options associated with the drop-down list for that data field will appear in the main panel of the Preferences pop-up box. By default, all of the options will be selected. Use the scroll bar to the right of the options list to navigate the list. 
3. Ensure that all of the options you wish to appear in the drop-down box for that data field are ticked, and all those you do not wish to appear are un-ticked. You will need to use the mouse to do this.
You can use the Toggle button on the right-hand side of the box to select or deselect all of the options in the list.
4. Click the Apply button > click the OK button to finish. The Preferences pop-up box will close and you will be returned to Taxonomic Editor.
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4.1.2 Adding New Options to Drop-Down Menus
For some data fields in a Taxonomic Database there are so many possible options that it is impractical to add all of them by default. Therefore there may be occasions where you wish to be able to apply a value to a data field but do not have an option to do so within the drop-down list for that data field, or there is no data field to accommodate the information you wish to enter. 

To allow for this, some fields allow for new options to be added:
> Description: You can add a new data field to the Descriptive panel.

> Features: the features you would like to include in your taxon descriptions, for example “common name”, “distribution” and “ecology”. 
> Named Area Type: you can add a new data option to the Named Area Type field drop down box found in the Details sheet.
> Extension Types: You can add a new data option to the Extension Type field drop-down box found in the Supplemental Data panel. 
> Marker Types: You can add a new data option to the Marker Type field drop-down box found in the Supplemental Data panel.
1. Open the Preferences pop-up box (Toolbar > Window menu > Preferences option). 
2. Navigate to the element you wish to change by expanding the Taxonomic Editor > Description  menu found in the Taxonomic Editor menu: 
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3. Click on the data field you would like to add to from the menu on the left hand side of the pop-up. The existing options associated with the drop-down list for that data field will appear in the main panel of the pop-up box. The example shown below is adding a new feature or data field to the overall Description.
4. Click the New button.
5. Give the new data field a Label, an abbreviation if desired and a description if desired. Only the data label is mandatory.
6. Click the Finish button.
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Your new data option will be added to the drop-down box for the selected data field in the Properties Sheet.

Please Note: The Remove option is not yet functional in this version of the Editor.

4.1.3 Editing Options of Drop-Down Menus
The Taxonomic Editor gives you the option to edit existing options of some drop-down boxes, as well as selecting/deselecting and the creation of new options as described in the above sections. Editing options allows you to change the name of the feature, abbreviation, and to add a description. This may be useful if your datasets has several users and you wish to provide information so that the data fields are used in a standardised way.
Options found in the following menus can be edited:

Preferences > Description > Features for example “common name”, “distribution” and “ecology”.

Preferences > Taxonomic  > Extension Types
An example of how to edit a Feature of the Description menu is given below. For more information on the Descriptive element of the Taxonomic Editor see section 8.0 Adding Descriptive Data to Taxon on page 89. 
1. Open the Preferences pop-up box (Toolbar > Window menu > Preferences option). 
2. Navigate to the element you wish to change by expanding the Description or Taxonomic menus found in the Taxonomic Editor menu: 
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3. Click on the data field you would like to edit so that it is highlighted. The example shown below is editing the Conservation feature.
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4. Click the Edit button:
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The “Edit Feature” pop-up box will open.

5. Edit the feature as desired. An example is given below:
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6. Click the Finish button:
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If you have edited the name of the Feature this will be immediately visible in the Features list:
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The Show View Menu

The five panels of the Taxonomic Editor can be closed independently by clicking on the (x) icon on the right-hand side of the tab of each panel. For example:
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Panels can be reopened by clicking the panel name under the Show View menu. 

1. Click the Windows menu in the Toolbar. A drop-down box will appear.
2. Move the mouse to the Show View option in the drop-down box. 

[image: image68.png]My Clss]___ Preferences
Revision of Mpoa |
i
Alpis acuminata
Alpia angustiola
Al angustisima Mer. &
Al arfakenss Kaneh. & Hat

User Manager
Messages AteshifteQ L
Reporting





Toolbar > Window > Show View
3. Click the panel option that you wish to open.

The panel will re-open in the Taxonomic Editor window.

The Taxon Name panel is automatically re-activated after double-clicking on a taxon record in the Taxonomic Tree panel. 

Tip! If, when you select a panel in the Show View menu you still cannot see it in the Taxonomic Editor window, it may have been minimised. Check at the bottom right of the window for minimised panels:
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4.1.4 Changing Panel Sizes
Each individual panel on the Taxonomic Editor can be resized using the mouse; as you point the mouse arrow on the join between two panels a double-headed arrow will appear. Simply press and hold the left mouse button and move the mouse until the panel is in the desired position and release the left mouse button.

The entire Taxonomic Editor can also be resized in this way. It also has the standard minimise, maximise and exit buttons at the top right of the window. 

4.1.5 Opening and Closing Panels

Each individual panel can be minimised/maximised using the icons at the top right of the panel, or closed using the ‘X’ icon on the tab bearing the name of each panel: 
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The panels can be reopened using the Show View menu (see The Show View Menu on page 38).

4.1.6 Customising Views of the Taxonomic Editor
If you have been used to earlier versions of the editor you will find the degree of control you have over the layout of the editor has increased significantly. In earlier versions of the editor tabs were fixed within a data entry panel and each panel was fixed in one of the three columns of the editor.  It is now possible to position any panel within any of the 3 columns, place any tab within any panel and create new panels simply by dragging a dropping elements of the interface. 

Perspectives

Before describing how to go about rearranging elements of the interface it is necessary to explain the concept of perspectives. There are three perspectives available in the interface: Taxonomic, Bulk editor and Polytomous Key. The changes you make to the layout of the editor will apply only to the currently active perspective. This will eventually allow you to create three independent arrangements of the editor which best suit your work flow within each perspective.
N.B. The Polytomous Key function is not available in this version of the Editor.

By default the taxonomic perspective is loaded however after first use of the editor the last used perspective will be displayed when the editor is restarted.

To open a perspective 
1. Click on the “open perspective button”
2.  Select other.  A list of available perspectives will be displayed in the “open perspective” pop-up. Select a perspective and it will open in the editor. 
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After a new perspective has been opened the last perspective viewed will remain open but will be hidden and replaced by the new perspective. A new button will be added to the perspectives tab allowing you to quickly switch between perspectives. 
After a new button has been added to the perspective tabs you may find that there is insufficient room to display all the buttons in which case the perspective tabs will display a double headed arrow on the right hand side as shown below. 
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To reveal the hidden buttons you can either click on the double headed arrow, the results of which are shown below

                                                             [image: image73.png]



Or you can hover the mouse over the left hand edge of the tab until the cursor changes to a double headed arrow as shown below. 

                                                    [image: image74.png]



When the cursor changes in this way left click the mouse and drag the edge of the tab to the left to enlarge it. Release the mouse button when you are happy with the size of the tab. The following screen shot shows the editor with the perspective tab enlarge sufficiently to display all three open perspective buttons and with the taxonomic perspective currently active.
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The screen shots below show the effect of changing between a taxonomic and bulk editing frame work.

Default Taxonomic Perspective
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Bulk Editing Perspective
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Moving panels 
N.B. before moving a panel make sure that you have the correct perspective open.

1. Left click on the grey area of the top tab of a panel and keep holding the mouse button down, a grey box will appear around the panel. 
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2. Drag panel to new location. The grey box shows where the panel will be moved to. It is best to experiment with moving panels around the interface in order to get the hang of this behaviour. In the examples below the details panel is moved in front of the descriptive panel, to form a new column alongside the taxon name tabs and beneath the descriptive panel.




Panels can also be detached from the workspace. This can be done in two ways. 

1.  Drag the grey outline of the panel  out of the workspace the release the button
2. Right click on the tab at the top of the panel and select detached form the drop down menu.
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To reattach the panel again right click in heading tab and unselect detached tick box.
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5.0 Creating and Building your Database 
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Note on terms and organisation within the Taxonomic Editor

The Taxonomic Editor allows for the input of data in a hierarchical way. Databases within the Taxonomic Editor consist of Taxonomic classifications composed of linked child nodes representing the taxa in the classification:









You can have several classifications within your database, with unlimited numbers of taxa in each one. Synonyms can be attached to taxa at any level in the classification.

Creating a New Taxonomic Classification with Reference Details
When using the Taxonomic Editor for the first time, you will need to create a new Classification. This will create a root within the Classification panel to which all following taxa records will be anchored. You can create a new Classification via the General menu:

1. Click the General menu in the Toolbar > move the mouse to the New option; a drop-down menu will appear > Click the Classification option:
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Alternatively, you can access the New > Classification menu by clicking the right mouse button with the mouse arrow pointing within the Taxon Navigator panel.
2. Enter a label for the Classification. This could be the name of a project or publication, for example:
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You may enter reference details if you wish:

3. Click the Browse button to the right of the Reference field:
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`
A new pop-up box entitled “Choose a reference” will appear. The cursor will appear in the search box by default. You can search here for a reference that you already have within your database:
4. Type in the title of the reference; as you type, matching references from within your database will be filtered and shown in the “Matching items” box beneath the search box: 
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If you are creating a new database or do not have the required reference already input, you can choose to create a new reference by clicking the text at the bottom of the “Choose a reference” box:
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5. The “Create reference” pop-up box will appear:
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Choose a reference type from the drop-down menu:
6. Click on the arrow to the right of the Reference Type field; a drop-down list will appear:
[image: image88.jpg]Refeence Cache |

Reference Type
Title

Author

In Reference.
Editor

Series

Volume

Pages

Date Published

URL

|

Generic B

In Pru(udlnis

Map

Patent

Personal Communication
Print Series

Proceedings

Report

Thesis -

» Date Details





7. Scroll down the list; there are several methods for doing this:
a. Use the mouse wheel if you have one;

b. Click and drag the position icon at the right hand side of the drop-down list;

c. Click the up and down arrows at the right hand side of the drop-down list.

8. Click the desired reference type; the drop-down list will close.

Alternatively to 6 and 7 above, type the first letter of the reference type you wish to select whilst the reference type field is highlighted. Matching options will be shown each time you press the initial letter. Continue until the desired option is shown in the reference type field.

9. Enter the title of the reference in the title field.
10. To enter Author details click on browse existing. 
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11. The “choose team” pop up box will appear. The cursor will appear in the search box by default. You can search for an author or team of authors that you already have within your database: 
12. Type in the name of the Author; as you type, matching authors from within your database will be filtered down and shown in the “matching items” box beneath the search box.
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If you are creating a new database or do not have the required author already input, you can choose to create a new author by clicking on the text at the bottom of the “Choose Team” box.
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13. The “New Entity” pop-up box will appear
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14. Click on the + sign to add team member. A” person” field will then appear. 
15. Click on the edit button
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16. A ‘new entity’ free text box will pop-up. To enter a person (author) click on the edit button. The fields will become white and can now be edited.
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17. Enter author name and click on edit.
18. Click finish.
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19. The name will then automatically appear in the Choose a person pop-up box. 

20. Select OK.

[image: image96.png]2 Choose a.

Use " for wildcard, or ?to see all entries

D.E Middleton
Matching items:
D.EMiddieton
Click link to create a new 52z,
D.E Middieton





21. Click finish on new entity pop-up box. Or if there are multiple authors repeat steps 14 to 21 to add additional people.
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22. Click OK in Choose Team pop-up box

[image: image98.png]32 New Taxonomic Tree

=

Taxonomic Tree

Create a new Taxonomic Tree.

Labek: Revision of Alyxia

Reference [ Viddieton, DJ. 2000, Revision of Ay, Part 1 Asaand Vil [Browse

| eference el 1146]





23. The author will now appear in the reference box.
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24. Complete the rest of the free text boxes. Depending on the reference type there may be other fields which need to be filled from the database. The process will be the same as outlined above.

25. Select Finish.
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26.  Select OK in “Choose a Reference” pop-up box.
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27. Click finish in New Classification pop-up
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28. The name of your new Classification will appear in the Taxon Navigator panel:
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It is possible to have more than one Classification in your database. Simply create a new Classification using the method above. The classification will be listed in the Taxon Navigator panel simultaneously. Also note that the classification names are displayed in a lighter colour than the actual taxa names. You can use the arrows to the left of the taxonomic tree labels and the taxon nodes to show or hide the child taxon/taxa that are attached to that tree or taxon:
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Adding Taxa to your Taxonomic Tree the quick way 
Once you have created your first Classification, you can add taxa to build up your database according to your taxonomic treatment. You add taxa to your classification by creating a new taxon linked to both the classification and a parent taxon if appropriate. The following description is the quickest way to add a new taxon to your tree:

Point the mouse arrow at the Classification or the intended parent taxon of your new taxon. As you hover over the entries in the Taxon Navigator panel they will become highlighted and a hand icon will appear.

1. Click the right mouse button; a drop-down menu will appear.

2. Point the mouse at the “New” option; a drop-down menu will appear.
3. Click Taxon:
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4. Enter the name of the taxon, including authorship if you wish. 
5. Click the Finish button or press the Return button on the keyboard:
[image: image106.jpg]3 New Entity (==

Taxon
Classification Revision of Alyia
Parent Alyxia R. Br. sec. Revision of Alyda. Part 1: Asia and Malesia

Reuse evsting Taxon

| Reuse evisting name.

New Taxon Alpia acuminata K. Schum.
Openin Editor





The new taxon record will appear in the Taxon Navigator panel and is saved automatically:
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You can continue to add new taxa to any node in the classification in this way in order to build up your taxonomic treatment. To create and manage synonyms and other relationships, see Managing Taxonomic Relationships on page 80.

If you want to open the taxon record to view the parsing status of the information you have input (see Parsing Status Feedback on page 65) or add to or edit the record (see the following section), simply double-click the taxon name in the Taxon Navigator panel.

Adding Taxa to your Classification using the General>New menu
As well as the above method, you can also access the New Taxon Node box via the General > New menu on the toolbar. However, using this method you may need to manually input the classification and the Parent Taxon (if any) of the taxon that you are inputting. If a classification is highlighted in the Taxon Navigator panel this is automatically selected as the classification.
1. Click on the General menu in the toolbar > New > Taxon:
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The New Taxon pop-up box will open. 
2. Click the Browse button to the right of the Classification field:
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The “Choose a classification” pop-up box will open.

3. Enter a search term for the name of the Classification, for example the first letter of the name. As you type, matching taxonomic trees will be shown in the “Matching items” field below:
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4. Click the name of the desired classification from the list in the “Matching items” field.
5. Click OK; the pop-up box will close and the name of the Classification will be shown in the Classification field:
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If appropriate, you can now choose a parent to attach the new taxon to in the exact same way:

6. Click the Browse button to the right of the Parent field:
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The “Select parent taxon” pop-up box will open.

7. Select classification from drop down at the bottom of the box.
8. Enter a search term for the name of the parent taxon, for example the first letter of the name. As you type, matching taxa from your selected Taxonomic Tree will be shown in the “Matching items” field below:
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9. Click the name of the desired parent taxon from the list in the “Matching items” field.

10. Click OK; the pop-up box will close and the name of the parent taxon will be shown in the Parent field:
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10. Click in the New Taxon field.  

11. Enter the name of the taxon, including authorship if you wish. 

12. Click the Finish button or press the Return button on the keyboard:
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The new taxon record will appear in the Taxon Navigator panel and is saved automatically:
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You can continue new taxa to any node in the classification in this way in order to build up your taxonomic treatment. To create and manage synonyms and other relationships, see Managing Taxonomic Relationships on page 80.

If you want to open the taxon record to view the parsing status of the information you have input (see Parsing Status Feedback on page 65) or add to or edit the record (see the following section), simply double-click the taxon name in the Taxon Navigator panel.
6.0 Editing your Taxa
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Parsing Status Feedback
Parsing is the automatic separation of taxa data into its constituents parts, which is then stored separately in the database. Editing your taxa records may therefore involve checking and editing the parsing behaviour. The results of parsing your data will be displayed in the Details Sheet. 

The Taxonomic Editor will display the parsing status of a record when it is open in the Taxon Name panel.  If the taxon record you would like to check is not open, you can navigate and activate the record as described in The Taxon Name Panel  on page 24. 

The parsing status is shown in the form of warning icons to the left of the taxon name and lines beneath the taxon name in the Taxon Name panel. Hovering over a warning icon with the mouse arrow will reveal a more detailed messages (the messages shown below are examples). The colours of the icons are also indications of the type of warning. There are three possible parsing states:

6.1.1 Red warning icon = Parsing has been unsuccessful 

                             [image: image118.jpg]



The taxon name will be underlined in red and there will be the red warning sign [image: image119.png]


  to the left of the taxon name. This warning sign indicates that the parser has not been able to separate the text string into its constituent parts. 

You can rectify this by editing the taxon information, if necessary, in the Details Sheet (see Dealing with Parsing Problems below).
6.1.2 Orange warning icon = Parsing completed but checks are recommended
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The taxon name will be underlined in orange and there will be an orange warning sign [image: image121.png]


  to the left of the taxon name. This indicates that parsing has been successful, but that there is an element of uncertainty and you may want to check that the parser has correctly inserted the separate elements of your text string in the correct data fields. Hovering over the warning sign will give you details on which element to check. In the example above the warning says to check that the Rank status has been accurately determined. You have to check this in the Details Panel (see Dealing with Parsing Problems below).
6.1.3 Black text only = No warning signal
A successful parsing action will be apparent from the lack of a warning sign and no underline appearing beneath the name in the Taxon Name panel. This indicates that the text string has been separated into its constituent parts with confidence. 
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You may still check the parsing results in the Details Panel if you wish (see Dealing with Parsing Problems below). 
6.1.4 A Successfully Parsed Taxon Record

A successfully parsed taxon record is given in the following example. You should note there is no warn symbol in the Taxon Name panel, and the Uninomial, Specific Epithet and Authorship of the new taxon, shown in the Name Cache menu, have been parsed to the correct locations.
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Dealing with Parsing Problems
If you have received a warning sign after entering a new taxon (see Parsing Status Feedback above) or would like to check the parsing results you will need to check these data fields in the Details Panel. This panel is an editable display of the data fields that are contained within the database. A taxon record is displayed in the Details Panel when it has been activated in the Taxon Name panel. If the taxon you need to edit is not yet open you can activate it by double-clicking the taxon record in the Taxon Navigator panel (see The Taxon Name Panel  on page 4 for further details).
Initially you will need to expand the high level menus to reveal the relevant data fields and further menus below them. This will include at least the Name menu and Scientific Name sub-menu, but you may also need to expand the Authorship sub-menu depending on the information you are checking/editing. 

The menus can be expanded or minimised using the arrow icons to the left of the appropriate menu. These arrows are only activated when the mouse arrow is located within the Details panel. 
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This version of the manual explains how to address problems with the basic data fields of Rank, Uninomial and Specific Epithet. The Parsing Status field at the bottom of the Details panel will inform you of which field to check:   
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Remember, if there continues to be a parsing problem after you have checked that the correct data is stored in the correct data field, the record can remain as it is; you will not be forced to eliminate the parsing problem before the data can be saved. 

6.1.5 Rank

The Parsing Status of the field may ask you to check the Rank data field. If the rank is correct, there is no need to take any action. If the rank is incorrect, you can change it using the drop-down menu: 
1. Expand the Scientific Name menu using the arrow to the left of the menu. 

2. Click within the Rank data field; the field will be activated and a drop-down menu arrow will appear at the right of the field.
3. Click on the drop-down menu arrow; the data options for the Rank field will appear.

4. Navigate to the correct rank value using the bar at the right hand side of the menu to scroll down if necessary.
5. Click the correct rank value; the drop-down menu will close and the selected rank will be shown in the rank data field.
6. Save the record (see Saving your Work on page 77).
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Note the many options in the Rank drop-down menu. This menu can be customised to show only those ranks which you are likely to use. See Show/Hide Options of Drop-Down Menus on page 30 for further information.
6.1.6 Uninomial and Specific Epithet
In order for these fields to be visible, both the Accepted Name and Name Cache menus need to be expanded using the arrows to the left of the data field name: 
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If these fields are incorrect, they can be edited simply:

1. Click in the relevant field; the field will become highlighted: 
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2. Make the correction.
3. Save the record (see Saving your Work on page 77).
Adding the Nomenclatural Status of a Name using the Details Panel
The Details panel can be used to assign a status to a taxon name, for example, illegitimate, invalid, valid.

If the taxon you want to edit is not yet open you can activate it by double-clicking the taxon record in the Taxon Navigator (see The Taxon Name Panel on page 224 for further details).

1. Expand the Nomenclatural Status menu by clicking the arrow icon to the left of the field label:
2. Click on the + symbol in the Nomenclatural Status box.
[image: image130.png](2 Alydia angustifolia 52 =8 =g
: = » Taxon: Alyxia angustifola sec. D.E Middieton, Revision of Alyca. Part
= Alyxia angustifolia xon: Alpda ang
S Name: Alveis snoectifa
» Nomendltural Reference
~ Nomendiatural Status ¥
No nomencistur! status yet.

 Protologues ¥
» Type Designations ¥
» Name Relationship ¥
 Hybrid





3. Click on the arrow in Nomenclatural Status type field; a drop-down menu will appear at the right of the field.
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4. To navigate to and select the nomenclatural status you have several options:

a. Use the up and down arrows on the keyboard until the desired nomenclatural status is highlighted and press the return button. 

b. Navigate the menu by using the mouse to move the scroll bar to the right of the menu up and down, or if your mouse has a wheel you can also use that. Click on the desired nomenclatural status.

c. Type the first letter of the name of the nomenclatural status, for example, “V” for “Valid”. The Editor will automatically jump to the first entry within the menu with that first letter. Repeat pressing the letter until the desired nomenclatural status is highlighted and press the return button. 
The drop-down menu will close, your selection will be shown in the Nomenclatural Status field, and the text string in the Taxon Name panel will be updated:
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5. Save the record (see Saving your Work on page 77).

It is also possible to add further information regarding the Nomenclatural Status using the other free text (Rule Considered and Reference detail) and Browse boxes in the Details panel.
Deleting a Taxon

There are two ways of deleting a taxon:

1. Click on the taxon in the Taxon Navigator panel > press delete on the keyboard > go to step 3., or:

2. Point the mouse arrow at the taxon name in the Taxon Navigator panel and click the right mouse button; a drop-down menu will appear > click the Delete option.    
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A pop-up box will appear asking you for confirmation to delete the taxon from the taxon navigator.
3. Click the OK button:
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The taxon will disappear from the Taxon Navigator panel.

Please Note: You can delete a taxon even if it has child taxa attached to it; all the records will be deleted. You cannot undo this action so you should be sure that this is what you want to do.

Bulk Editing
6.1.7 About Bulk Editing
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Toolbar >General > Bulk Editor menu

The bulk editor allows multiple taxon records that share Names, Name Relationships, References, Specimens and Observations, or Authors and Author Teams data to be edited. These data types are not easily edited in the course of normal taxon editing and are frequently referenced (shared) in several places within a dataset, therefore they are edited in a separate location. 
Furthermore References frequently contain a number of duplicate entries, for example, after a mass import, where multiple entries for a single object must be merged to insure data integrity. The Bulk Editor allows you to search for and merge duplicate reference records.
The Bulk Editor consists of a search field and a list editor. The list is populated when a search is executed. The Details Panel is used to display and edit details of the object which is currently activated; changes made in the Details Panel are reflected immediately in the list. 
This version of the manual will explain how to edit the name of multiple taxa records.

6.1.8 Bulk Editing Names
The bulk editor allows multiple taxon records that share Names, Name Relationships, References, Specimens and Observations, or Authors and Author Teams data to be edited. These data types are not easily edited in the course of normal taxon editing and are frequently referenced (shared) in several places within a dataset, therefore they are edited in a separate location. 

In this example, we search for all the taxa within a Genus and change the Genus name.
1. In the Toolbar area, click on the Window menu >Bulk Editor; a drop-down menu will appear.

2. Click the Name option.
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You will notice that a new tab has opened in the Taxon name panel titled Name. The tab has a search bar at the top and a blank space below which will display the results of your search.

3. Click in search box.
4. Enter a search term in the search box. 

To find multiple variations for the same name it is best to use a shortened version of the name with the ‘wildcard’ icon, an asterisk (*). The Taxonomic Editor will return all records that match the initial letters you have input but with no restrictions on the following characters (see the example below).
Press Return on the keyboard or click on the Search button to run your search. A list of matching records will appear beneath the search bar.
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You will also find that the Details Panel will display information regarding each entry in the search results when you double-click its name within the list:
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In order to now change the genus name of all the taxa displayed in the Taxon Names panel, click through the list and edit the name in the Details panel to the right:
5. Click on a taxon from the list in the Taxon Name panel; the taxon record will be activated in the Details panel as shown above.

6. Expand the Name menu by clicking the arrow icon to the left of the field label:
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7. Click on Edit.
8. Edit the taxon name as desired, for example:
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9. Click on Edit to finish. 

10. Click the Save icon in the toolbar;  the name will automatically be changed in the Taxon Names panel and in the Taxon Navigator:
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You can now move down the list in the Taxon Names tab and edit all the names as described above.

Saving your Work 

Any record that has been edited without being saved will be flagged with an asterisk in the Taxon Name panel to the left of the taxon name in the tab label:

An asterisk indicates unsaved changes
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You can save your changes using the Save icon on the Toolbar and at the top left of the Taxonomic Editor window:
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Alternatively, hold the Control and S keys on the keyboard at the same time.

Please Note: If you have multiple taxon records with unsaved changes this method will only save changes in the currently activated record i.e. the record that is open in the Taxon Name panel. To save all unsaved changes in multiple records you need to select the Save All option found under the General menu:

Click on the General menu in the Toolbar; the File drop-down menu will appear > Click on Save All.
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If you attempt to try to close an edited taxon record without saving your changes the Taxonomic Editor will give you a warning:
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Any changes to text in the Taxon Name panel will not appear in the Taxon Navigator panel until the changes have been saved as above. Alternatively, you can refresh the classification by right-clicking anywhere in the Taxon Navigator panel and selecting Refresh:

Point the mouse arrow anywhere within the Taxon Navigator panel > Click the right mouse button; a drop-down menu will appear > Click the Refresh option.
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7.0 Managing Taxonomic Relationships 

 SHAPE  \* MERGEFORMAT 



Adding a Heterotypic Synonym

There is a quick and easy way of attaching synonyms to a taxon record:

1. In the Taxon Navigator panel, double-click the taxon to which you want to attach a synonym; this will open the record in the Taxon Name panel if it is not already open (see Activating Taxon Records on page 25 for more information).
2. Click in the Taxon Name panel to the right of any text already entered.

3. Press Return on the keyboard.

Another text box will appear in the Taxon Name panel, below that of the root taxon/accepted name for which you are entering a synonym. You will notice the standard taxonomic synonym indicator (=) at the left hand side of the new text box within a green circle:
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If the synonym text box was opened in error, point the mouse arrow into the synonym text box and click the right mouse button; a drop-down menu will open > click on the Delete option:
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4. Enter the name of the synonym. 
5. Save the synonym (see Saving Synonyms below).
Adding a Homotypic Synonym

By default, a carriage return from a taxon record in the Taxon Name panel will create a new text box for a heterotypic synonym, as detailed above. Homotypic synonyms can be added using a drop-down menu:
1. Point the mouse arrow into the text box for the taxon to which you are attaching a homotypic synonym and click the right mouse button; a drop-down menu will appear.
2. Point the mouse at the New option at the top of the menu; a new menu will appear.

3. Click on the Homotypic Synonym option:
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Another text box will appear in the Taxon Name panel, below that of the root taxon/accepted name for which you are entering a synonym. You will notice the homotypic synonym icon of (() inside a blue circle:
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6. Enter the name of the synonym. 

7. Save the synonym (see Saving Synonyms below).
Saving Synonyms

You can save synonym records by either:

1. Pressing Control and S together on the keyboard, or by:

2. Pointing the mouse arrow into the synonym text box and click the right mouse button; a drop-down menu will open > click on the Save option:
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Editing Synonyms

A synonym name is parsed in exactly the same way as a root or child taxon. However, in the Details  panel you will see that Synonym Name is seen at the top, rather than Accepted Name. The details of a synonym name can be expanded and edited in the Details panel in the same was as a child taxon (see Editing your Taxa on page 66).
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Deleting a Synonym 

1. The accepted name to which the synonym you wish to delete has to be open in the Taxon Name panel (see The Taxon Name Panel  on page 24 to learn how to search for and open a taxon record).

2. When the record is open, point the mouse arrow into the text box of the synonym you want to delete within the Taxon Name panel.

3. Click the right mouse button; a drop-down menu will appear.

4. Click the delete option.

          [image: image154.jpg]= O etaits 2
» Synonym: Adichiea Hendel 1911 sec.

= Aldrichiomyza Hendel, 1914 in Ent. Mitt.

73.1914, nom. nov. = Name: NichielsHendel 1911
© AldrichicllaHendel, 1911in Wien. ent. 2tg.30: | Cache Aidichit Hend,
35. 1911, nom. lleg. -
[ New »
ChangeTo »
® Delee Deete

SetasOriginal Combinaton for Homatypic Group.
Swap Synonym With Accepted

Swe cules.





5. Save your changes (see Saving your Work on page 77).

Changing a Synonym to an Accepted Name

1. The accepted name taxon record which has the synonym attached to it that you wish to change to an accepted name has to be open in the Taxon Names panel (see The Taxon Name Panel  on page 24 to learn how to search for and open a taxon record).

2. Right-click anywhere within the text box of the synonym in the Taxon Names panel; a drop-down menu will appear. 

3. Point the mouse arrow over the Change To option; a new drop-down menu will appear.

4. Click the Accepted Name option:
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5. Save your changes (see Saving Synonyms on page 81 above); your changes will appear in the Taxon Navigator panel:
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Changing an Accepted Name to a Synonym

1. The accepted name taxon record that you wish to change to a synonym has to be open in the Taxon Name panel (see The Taxon Name Panel  on page 24 to learn how to search for and open a taxon record).

2. Right-click anywhere within the text box of the taxon record in the Taxon Name panel; a drop-down menu will appear. 
3. Click on the option “Change Accepted Taxon to a Synonym”:
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The “Choose the accepted taxon” pop-up box will open.

4. Enter the name of the accepted name that you wish to attach the synonym to in the search bar at the top of the pop-up box; as you type, matching entries will be filtered automatically and will be shown in the “Matching items” box beneath the search bar:
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5. Select the desired accepted name by either:
a. Point the mouse cursor to the desired accepted name and clicking the left mouse button twice; or

b. Point the mouse cursor to the desired accepted name; click the left mouse button once and then click the OK button.

The “Choose the accepted taxon” pop-up box will close and the record that has been edited will be shown as a synonym in the Taxon Name panel.
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The change is automatically saved.
Moving the Position of Taxa within a Taxonomic Tree
If a taxonomic treatment has changed and you need to update your classification to reflect this, this can be done easily via the Move Taxon (with Child taxa) function. This function allows you to move a taxon with any associated synonyms and child taxa.
1. Point the mouse arrow at the taxon name which you want to change within the Taxon Navigator panel.

2. Click the right mouse button; a drop-down menu will appear.

3. Click the Move Taxon (with child taxa) option:
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4. The “Choose new parent” pop-up box will open. Select the classification in which you are searching in the drop down menu at the bottom of the box.

5.  In the text box at the top of the box, enter a term to search for the parent taxon to which you would like to move the child to. As you type the Taxonomic Editor will automatically search for matching taxon names. You can also use (*) to search using part of the name, or (?) to see all entries. A list will appear with matching taxon names:
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6. Click on the name of the desired parent taxon.

7. Click the OK button or press Return on the keyboard. Alternatively, simply double-click the name of the desired parent taxon.

8. The location of the selected child taxon will be moved within the Taxonomic Tree and will be saved automatically:
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8.0 Adding Descriptive Data to Taxon Record
There is a variety of types of descriptive data that can be added to a taxon (shown below). If you do not need to use all of these kinds of data you can remove the available descriptive data types via the Preferences menu as explained in Show/Hide Options of Drop-Down Menus  on page 30. Due to the variety of data types available, examples will be given here rather than instructions specific to every data type.
Please Note: The Descriptive Data element is under construction and there may be some changes to later versions of the Taxonomic Editor.

Types of Descriptive Data

The descriptive data panel allows you to attach descriptive data to each taxon within your taxonomic tree. The following types of data can be included:

	Abstract
	Discussion
	Observation

	Acknowledgements
	Distribution
	Occurrence

	Additional Publication
	Ecology
	Pathogen Agent

	Anatomy
	Etymology
	Phenology

	Biology and Ecology
	Habitat
	Protologue

	Chromosome
	Host Plant
	Specimen

	Citation
	Individuals Association
	Synopsis

	Common Name
	Introduction
	Unknown Feature Type

	Conservation
	Key
	Uses

	Cultivation
	Materials Examined
	

	Description
	Materials Methods
	

	Diagnosis
	Multiple
	

	
	
	


The format of the types of descriptive data varies; for some the data is input as freetext but for others data must be chosen from options given in drop-down menus. 

Please Note: The options given to you in the drop-down menus can be customised using the Preferences menu (see Show/Hide Options of Drop-Down Menus  on page 30).
Opening the Descriptive Panel for a Taxon 
The Descriptive Panel can be viewed via the windows menu.  Windows > Show View > Descriptive.  A taxon has to be included in the Taxon Navigator panel and has to be activated within the Taxon Names panel before descriptive data can be added to that taxon.
Adding a Description Tree to a Taxon
The taxon must first be activated in the Taxon Name panel. 
The Description Panel must also be open Windows > Show View > Descriptive. 

1. Point the mouse cursor in the Description panel box.

2. Click on the right hand mouse button and a menu will appear 

3. Select New Descriptive Data
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An entry will appear in the Descriptive panel and the “Description Details” box will open in the Details panel
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Building a Description Tree by adding Descriptive Data Types
A description tree must first be created for the taxon; see the section above.

1. Point the mouse cursor at the entry in the Descriptive panel.
2. Press the right-hand mouse button; a menu will appear.

3. Point the mouse cursor at the “New” option in the menu; a drop-down menu of all available descriptive data types will be shown:
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4. Click on the descriptive data type that you wish to enter for the taxon, for example “Common Name”; the data type will be added to the Description Tree and its specific data entry box will be activated in the Details panel:
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A customised Descriptive Tree consisting of different description types can be created in this way. As stated previously the format of the types of descriptive data varies; for some the data is input as free text but for others data must be chosen from options given in a drop-down menu. Therefore examples of how to input certain descriptive data types will be given in the following sections, rather than showing how to input data for each data type. 
Adding Common Name Descriptive Data to a Taxon Record
Add the descriptive data type of “Common Name” as described in section 8.4 above. The Details panel should look like this.
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Tip! Each individual panel of the Taxonomic Editor can be resized; if you are having difficulties viewing the entire Descriptions panel you can use the arrows which appear at the top, bottom, left and right of the panel to resize it (see Changing Panel Sizes page 39).
1. Click in the “Language” field in the Common Name Details box; the field will be highlighted and a drop-down menu will appear:
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2. Enter the first digit of the name of the language. The first language name that begins with that letter will be shown. Continue to enter the first digit of the name until the language you wish to select is shown in the highlighted box. 

For example, to input the language of the common name as “Thai”, after clicking and highlighting the Language field, press “T” on the keyboard. Repeat the pressing until the name “Thai” in shown the Language field:
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3. When the language you want to select is shown in the Language field, press return on the keyboard to confirm your selection; the drop-down menu will close and your selection will be shown in the Language field:
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4. Click in the “Common Name” field in the Common Name Details box; the cursor will appear in the box.
5. Type in the common name of the activated Taxon; the text will appear in the Common Name field:
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6. Save the changes by clicking on the Save icon:
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Adding a Species Description to a Taxon Record

Add the descriptive data type of “Description” as described in section 8.4 above. The Descriptive panel should look like this:
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As with several other descriptive data types available, the description of a species is added as free text.
1. Point the mouse cursor in the Details box; the cursor will appear.

2. Type in your species description, this will appear automatically in the Descriptive panel. For example:
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Tip! You can also cut and paste text from a word document or another database where you store taxonomic information. Simply highlight the text you want to copy from the original document, press Ctrl on your keyboard and then C whilst still holding the Ctrl button. Release both buttons. You have just copied the text. Now click in the box of the Taxonomic Editor where you would like to paste the text and press Ctrl and then V whilst still holding the Ctrl button. The text will be pasted.
3. Save the changes by clicking on the Save icon:
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9.0 Adding Supplemental Data to a Taxon Record

The Supplemental data panel is accessed in the same way as the descriptive panel.  Windows > Show View > Supplemental.
Types of Supplemental Data 

The Supplemental data panel allows you to attach supplemental data to each taxon within your classification. The following types of data can be included:
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The format of the types of descriptive data varies; for some the data is input as free text but for others data must be chosen from options given in drop-down menus. 

Please Note: The options given to you in the drop-down menus can be customised using the Preferences menu (see Show/Hide Options of Drop-Down Menus  on page 30).

Adding annotations to Taxon Record
The following is an example of how to use the supplemental data panel.  The taxon must first be activated in the Taxon Name panel. The Supplemental data Panel must also be open Windows > Show View >Supplemental. 

1. Expand Annotations box using the arrow to the left of the data box name

2. Add new annotation by clicking on the + symbol on the right of the box
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3. Select annotation type from the drop down box; editorial or technical 

4. Enter annotation to freetext box 
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10.0 Adding Media Data to a Taxon Record 

Create an image gallery 

The taxon must first be activated in the Taxon Name panel. The Media Panel must also be open Windows > Show View > Media. 

1. Point the mouse cursor in the Media panel.

2. Click on the right hand mouse button and a menu will appear 

3. Select New Image Gallery 
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4. Click on Image gallery to open in details panel . You can change the label here, should you wish, in the Label freetext box.
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5. Expand the image gallery by clicking on the menu arrow in the media panel. There will already be one existing ‘empty media’. 
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6. To add additional images (or galleries) right click in the window and make selection from menu.
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7. Click on image to open in details panel.
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8. Add title, artist and description as required. This will automatically be updated in the Media window. Then click on + symbol to expand Media Representation menu.
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9. Enter the type of image file in the Mime type field. Click on the + symbol to expand Media Representation Part menu.
[image: image186.png]



10. Enter the URI of where the image is to be found in the URI field. The size, height and width fields will be automatically filled. The image will be visible beneath this.
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This section tells you how to:


Download and install the Taxonomic Editor for the first time.


Create a desktop shortcut.


Install updates of previously installed features.


Search for and install new features.


Remove the Taxonomic Editor.


Ensure that Unicode characters such as ♀ and ♂ are visible.





“Save As” details box: choose a location and name for the folder (choose a new name or keep the default) and Save.





Windows Start button





This section will teach you about:


The different parts or panels of the Taxonomic Editor.


The menus; their contents and functions.


Standard commands and functions.
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All criteria will be included in searches





Only (accepted) Taxa and Synonyms will be included in searches





Taxa with currently displayed tabs





Open taxa with tabs not currently displayed





This section tells you how to customise the Taxonomic Editor to suit your own needs. You can:


Pick and choose which options will appear in drop-down boxes.


Create new options/data fields for several parts of the database such as taxon descriptions.


Choose which panels of the Taxonomic Editor are displayed, where they appear in the editor and the size of each panel. 











Original Feature details





Edited Feature details





Maximise





Minimise





 Close





Details panel is moved to to create a new alongside the Descriptive panel.


The file icon (         )shows that the details panel will be stacked behind any panels which are located here already.





Details panel is moved to form a new column alongside the Taxon Name panel. NB this will now need to be resized to display the text.


The black arrow icon      ( � )shows that the details panel will form a new column rather than stacking behind the existing panels in the space.











Details panel is moved to form a new column alongside the Taxon Name panel.





This section tells you how to: 


Understand the hierarchical system of a Taxonomic Editor database.


Create and build a new taxonomic treatment database by creating taxonomic trees and adding child taxa.











Name of Project, programme etc





Classification e.g. Revision of Alyxia





Name of Order, Family, Genus, species etc





e.g. Alyxia





Child Taxon





Name of Child Taxa





e.g. Alyxia marginata





Child Taxonn





Child Taxon





Synonyms can be attached to a Child taxon at any level in the hierarchy.





e.g. Alyxia scabrida





Synonym





                Show/Hide children arrow





               Classifications





 Taxa





In this example Alyxia will be the parent taxon of the new taxon, as indicated by the fact that it is highlighted.








Input a search term here





As you type, matching items will be shown here








Input a search term here


As you type, matching items will be shown here





This section tells you how to: 


Check the parsing status of your taxon records.


Deal with parsing problems by editing basic fields in the Properties Sheet.


Delete a taxon from your taxonomic treatment.


Understand the bulk editor and how to use it to merge duplicate entries.


Save you work. 





No warning signal





If you see this parsing status you should check the Uninomial and Specific Epithet fields





If you see this parsing status you should check the Rank field
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Right-click





This section tells you how to: 


Add heterotypic and homotypic synonyms to taxa.


Save, delete and edit synonyms.


Change a synonym to an accepted name.


Change the position of taxa within a taxonomic tree.











Right-click





Right-click





Right-click





Right-click





Matching entries will 


be shown here





Type the name of the accepted taxon here








Right click mouse in Descriptive panel
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